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A guideto thefull Excel 2016 (Part 12): Page
formatting and spreadsheet printing

Please join TipsMake.com to refer to the article on how to format the page and print the spreadsheet in Excel
2016!

Sometimes, you want to print Excel spreadsheets to view and share data offline. When choosing your page
layout setting, you can easily preview and print spreadsheets from Excel 2016 using the Print window. Please
join TipsMake.com to refer to the article on how to format the page and print the spreadsheet in Excel 2016 !

See the video below to learn more about page formatting and printing spreadsheets in Excel 2016:

Format pages and print Excel 2016 spreadsheets

'_\

. 1. Access the Print window
I1. Print a spreadsheet
3. lll. Select the print area
1. 1. Print the current worksheet
2. 2. Print the entire spreadsheet
3. 3. Print aselection
4. 1V. Adjust content
1. 1. Change page orientation
2. 2. Refine the content before printing
5. V. Usethe Print Titles command
6. VI. Adjust page breaks
7. VII. Modify the margin in Preview box:

N

|. Accessthe Print window

1. Select the File tab. The Backstage view mode will appear.
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2. Select Print . The Print window will appear.






Print window.
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I1. Print a spreadsheet

1. Navigate to the Print window, then select the desired printer.
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2. Enter the number of copies you want to print.
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3. Select additional settingsif needed.
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4. Click Print .

Print

! Copies |1 Z
Print I}
Printer i
Lexmark MX310dn

w
::‘:E Ready

Printer Properties

[11. Select the print area

Before printing an Excel spreadsheet, it isimportant to decide exactly what information you want to print. For
example, if you have multiple spreadsheets in your spreadsheet, you'll need to decide whether you want to print
the entire spreadsheet or just the active spreadsheets. Y ou may also want to print only selected content from the
spreadsheet.

1. Print the current wor ksheet

Spreadsheets are considered active when selected.
1. Select the spreadsheet you want to print. To print multiple sheets, click the worksheet first, hold down the Ctrl
key on the keyboard, then click the other worksheet you want to select.
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Ready
2. Navigate to the Print window.

3. Select Print Active Sheets from the Print Range drop-down menu.
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4. Click the Print button.
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2. Print the entir e spreadshest

1. Navigate to the Print window.

2. Select Print Entire Workbook from the Print Range drop-down menu.
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3. Click the Print button.
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3. Print a selection

In the example, we will print arecord for the top 40 salespeople in the central spreadsheet.

1. Select the cells you want to print.



2. Navigate to the Print window.

3. Select Print Selection from the Print Range drop-down menu.
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4. Y our preview selection will appear in the Preview window.
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5. Click the Print button to print the selection.
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1. If you wish, you caninstall the print areafirst to visualize which cells will be printed when you work in
Excel. Smply select the cells you want to print, click the Page Layout tab, select the Print Area command,
then select Set Print Area. Note that if you need to print the entire spreadsheet, you need to delete the
print area.
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V. Adjust content

Sometimes, you have to make minor adjustments from the Print box to make the spreadsheet content fit on one
printed page. The Print window includes a number of tools to help scale the content of your spreadsheet, such as
scaling and page margins.

1. Change page orientation

Excel 2016 offers two page orientation options: landscape and portrait . Landscape guides the page horizontaly,
while portrait orientation is vertical. In the example, we will set the landscape direction.

1. Navigate to the Print window.

2. Select the desired direction from the drop-down menu Page Orientation . In the example, we will select the
Landscape Orientation .
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3. New page orientation will be displayed in the Preview box.
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JANUARY FEBRUARY MARCH AP RIL Ay JumE
5 5 573500 § 685100 5 38EE00 S 825000 S B,
5 203500 ¢ 538500 763800 5 353300 % 56500 T 1,126.00
3 651000 5 404600 S 263200 & 7803.00 S 07600 S 5,130.00
5 716100 5 57700 5 860500 5 Ap45.00 5 863200 5 7,503.00
5 410600 5 7,17200 5 585100 5 212200 5 5,51200 5 BI5200
5 6758.00 5 201800 5 514400 5 706700 5 156800 5 522200
5 TET.00 5 1,54400 5 907100 5 5210.00 5 7,75000 5 4.275.00
5 404600 5 953200 5 7,503.00 § B392.00 5 74500 5 9,721.00
E B77E00 5 TITOD 5 §302.00 5 BA30.00 5 TEEIODO 3 487800
H 7,750.00 5 4,27500 § 4,267.00 5 £,755.00 5 §,01900 5§ 2,144.00
5 -5 5 853200 5 578300 5 4458300 5 847400 S 83517.00
5 141800 S 675500 & 901000 & 514400 & BS5000 © 573100
5 256000 S 25700 5 821000 5 5820300 § £50400 S 142200
5 457300 5 50500 % 321500 5 BEi7.00 5 523300 = 155000
L B755.00 3 825800 5 635.00 5 7087.00 5 156800 5 822200
5 7,703.00 5 7,23500 5 761000 5 2410.00 5 142500 S B732.00
5 703200 5 525500 5 221800 5 5105.00 5 2,85100 5 4,452.00
5 5233.00 S 1,65000 5 305200 5 377900 5 840500 5 3,585.00
5 627.00 5 790800 5 320000 5 7710.00 5 716100 5 577.00
5 186500 5 499600 592500 5 3API00 5 246900 5 £,116.00
E 4257.00 % 9,59000 5 ET00 5 EB210.00 5 77000 5 427500
H 4,596.00 5 B,43000 5 7,882.00 5 4BTE00 5 BES00 5 £,575.00
5 424700 & 5,%0000 £ 24700 % 821000 % 770000 S 4,000.00
] 822500 743000 & 7RR200 8 AT 00 & 188500 2 A4,826.00
L BI85.00 5 7,62100 S 34300 5 BOIS00 5 E3E00 S 840,00
5 407500 5 1,24000 5 224300 5 4363.00 5 342500 S 5,545.00
5 877500 5 704200 5 337300 5 4383.00 5 342500 5 5,545.00
5 E365.00 5 1,64500 5 352700 5 TA30.00 5 785200 S 4,876.00
5 526600 5 527600 5 BO3L00 5 457600 5 156500 5 459600
Hl BEEE00 5 3,42600 3 9.935.00 5 iS00 5 430500 F 553100
5 ESLE00 5 L1200 5 251800 5 756500 5 625500 5 B7R.00
5 305200 5 4,85300 5 FATA00 5 B517.00 5 523300 5 1,650.00
5 61500 5 531900 § 589100 § 433100 § 7,75200 § 3,786.00

2. Refine the content before printing

If some of your content is cut by the printer, you can use scaling to shrink the spreadsheet to the page
automatically.

1. Navigate to the Print window. In the example, we see in the Preview pane the spreadsheet content will be cut
when printing.

5 311000 S 573500 S 888100 S ZEES00 S 8,25200 S BSLR.00
5 553500 S 538500 763800 5 353300 % £,56500 S 1,126.00
5 £540.00 5 404500 S 553200 5 TR03.00 5 507500 5 513000
$ 7,161.00 5 57700 S 8,605.00 5 4045.00 5 5,63200 5 7,803.00
5 5 7,17200 5 695400 5 2120 S 5,520 5 BISLO0
5 6.759.00 5 9.01800 § 514400 5 TRET.00 5 1,56800 5 B.812.00
5 TET.00 5 1,54400 5 907100 5 5210.00 5 7,75000 5 a4375.00
5 404500 5 963200 5 7503.00 5 B381.00 5 74500 5 B7L00
5 8,778.00 5 TIT00 5 630200 5 BA30.00 5 788200 5 457E00
H 7,7%0.00 4,27800 & 436700 5 &785.00 & §,019.00 5 5,144.00
s 156800 & 552200 & 78800 & 488300 % 5,47400 5 8817.00
5 141800 S 679500 S 9,01900 5 514100 8 BS50.00 S 5,731 00
5 555000 S 25700 5 821000 5 5253.00 S 680200 5 1452 00
5 4573.00 S 50500 S 321500 5 B517.00 S 523300 S 155000
5 B765.00 S B,25800 5 63600 5 TPET.00 5 156800 S 832200
5 70300 5 7,23500 5 761900 5 2A10.00 5 142500 5 B732.00
5 703200 5 525500 5 921600 5 51065.00 5 28500 5 245200
5 5233.00 5 165000 § 305200 5 37700 5 240500 3 3,586.00
5 527.00 S 780800 5 320400 5 77i0.00 § 716100 5 5700
5 1,885.00 5 499600 5 5925.00 5 3A93.00 5 246900 5 1100
L} 4267.00 5 §,55000 5 25700 5 8210.00 5 7,750,000 5 427500
5 459800 § 8,43000 § 7,882.00 § 457800 5 88500 5 £,575.00
5 426700 5 §,595000 § 25700 S 821000 S 770000 5 4,000.00
5 £,225.00 § 7,43000 § 7,882.00 5 487600 S 188500 S 4,556.00
L3 B785.00 S 7,62100 S 343500 5 801500 S 524800 S 840.00
3 407500 5 1,24000 S 224300 5 438300 S 3,42500 S 5,545.00
5 8775.00 5 704200 5 337300 5 4383.00 S 342500 5 5545.00
5 B369.00 5 1,54500 5 3,517.00 5 TA30.00 5 788200 35 A4576.00
5 52BE00 3 527600 5 BO3L00 5 457500 § 1,38500 5 4,995.00
s 956500 5 1,12600 5 93500 5 251100 5 4,0500 5 553100
5 6516.00 5 1,11200 5 251600 § 75E5.00 5 6,25500 5 B7R.00
H 305200 % 4,85300 § $474.00 5 8517.00 5 523300 5 1,650.00
s 51500 5 531900 § 889100 & as333.00 5 7,78200 § 3,736.00

2. Select the desired option from the Scaling drop-down menu. In the example, we will choose Fit All Columns
on One Page .
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3. The worksheet will be collapsed to appear in afull page.

1. Note that spreadsheets will become more difficult to read because they are scaled down. Therefore, you
may not want to use this option when printing a spreadsheet with more information. In the example, we
will change the scaling setting to No Scaling .

V. UsethePrint Titlescommand

If your spreadsheet uses section headings, it isimportant to include the titles on each page of the printed
spreadsheet. It will be difficult to read a printed worksheet if the title only appears on the first page. The Print
Titles command allows you to select specific rows and columns that appear on each page.

1. Click the Page Layout tab on the Ribbon toolbar, then select the Print Titles command.
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2. The Page Setup dialog box will appear. From here, you can select repeating rows or columns on each page. In
the example, we will repeat the first row.

3. Click the Collapse Dialog button next to the Rows to repeat at top field: (The lines repeat at the beginning :).
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4. The cursor will become a small selection arrow and the Page Setup dialog box will be collapsed. Select the
row (S) you want to repeat at the top of each printed page. In the example, we will chooserow 1 .

FEBRUARY

Page Setup - Rows to repeat at top:

3
4 51:81|
il | Doyle, Quincy : 'T,M s 577.00 =3

5. Row 1 will be added to Rows to repeat at top:. Click the Collapse Diaog button.

6. The Page Setup dialog box will expand. To repeat a column, use the same procedure shown in steps 4 and 5.
In the example, we choose to repeat rows 1 and A.

7. When you're happy with your choices, click OK .
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8. In the example, row 1 appears at the top of each page and column A appears on the |eft side of each page.
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5 530200 § IIRO0 § 29800 3 496400 3 377800 3 737.00
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$ 284300 § 496400 3 L77E00 35 35700 5 557500 % 4045.00
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VI. Adjust page breaks

1. Click the Page Break Preview command to change to the Page Break view mode.

B E £ - | + 100%

Page Break Preview

2. Vertical and horizontal dashed dotted lines indicate page break points. Click and drag one of these linesto
adjust the page break.




4. In the example, all pages now display the same number of rows due to changes in the page break.



3 426700 5 5,59000 3 P 2000 3 775000 5 427500
$ 490600 § 43000 35 TERO 35 AEE00 5 BESOD S £57200
b1 436700 § 355000 § Frllee 2000 § 770000 5 4000,00
5 682500 5 743000 5 788200 35 ABFE00 5 1BES00 3§ 450600
H E7ER00 5 7100 5 34Em 5 ROISC0 § 524800 3 240,00
5 277200 § 79200 5 2280 3 277200 35 TORM 5 337300
5 877800 3 70200 S 3330 5 43B00 § 342500 $ 5,545.00
5 7[00 5 521000 35 7700 35 83R00 35 30 5 2845.00
H 61900 § 531200 5 BEEIO0 3 480600 5 BA43000 35 7.BE2.00
§ 28200 § 780300 5 E07E00 3 LS00 3 £355.00 3 §77.00
b3 651600 5 111200 $ 25600 3 7.56500 § 625600 5 E784.00
$ 306200 § 465300 5 347400 3 BST00 35 523300 3 LE50.00
3 873800 § 686100 § 38R0 § 35500 § 557500 $ 404600
3 AAE00 5 o,68200 5 7BB.00 3 454800 5 61800 5 531800
s 788200 3 4E7E00 5 LE85.00 3 00 5 B21000 § 590400
H 530200 § I[EOD § L3E.0 35 496400 35 277EQD 5 737.00
$ 35700 § 557500 § 4MME00 § 000 § BIE00 § 1645.00
5 28300 3 456400 35 377E00 5 15700 35 557500 35 404500
H 7,3500 § 71800 5 24000 5 600 5 521000 5 5.004.00
§ 240500 § 358800 3 181200 3 L4300 3 £7500 3 201200

VIl. Modify the margin in Preview box:

Margin is the space between the content and the edge of the page. Sometimes, you need to adjust the margin so
that the display datais easier to read. Y ou can modify page margins from the Print pane.

1. Navigate to the Print pane.

2. Select the desired margin size from the Page Margins drop-down menu. In the example, we choose Narrow
Margins.
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3. New margin will be displayed in the Preview box.
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1. You can manualy adjust the margin by clicking the Show Margins button in the lower right corner, then
dragging the margin line in the Preview window.

b

" asEmEEEEEEEEEE

Having fun!

Show Margins

Y ou finished reading the article "A guide to the full Excel 2016 (Part 12): Page formatting and spreadsheet
printing" edited by the TipsM ake team. We hope this article has provided you with many useful tech tips and
tricks. You can search for similar articles on tips and guides. Thank you for reading and for following us

regularly.
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